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ELISA CUANTITATIVO

REF.: ELISA3
6 grupos de estudiantes

1.0BJETIVO DEL EXPERIMENTO

El objetivo de esta practica es realizar y dominar los conceptos experimentales
y la metodologia implicados en un ensayo por inmunoabsorcion ligado a
enzimas (ELISA). Este experimento ELISA esta diseiado para detectar IgG
circulantes diferentes dirigidas a dos antigenos diferentes. Las observaciones
en esta practica incluyen la especificidad de anticuerpos, el efecto de diluciéon
sobre las reacciones de ELISA, el desarrollo del color y la cuantificacion.

2. COMPONENTES para 6 grupos de estudiantes

COMPONENTES Conservacion
A Antigeno A. nevera
B Antigeno B. nevera
C Tampon de dilucién nevera
D Anticuerpo primario A nevera
E Anticuerpo primarioB nevera
F 10X Tampon de Lavado nevera
G Anticuerpo secundario nevera
H ABTS nevera
I Solucion STOP nevera
Placas de microtitulacion. T2 ambiente
Pipetas de transferencia. T3 ambiente
Tubos de microcentrifuga. Ta ambiente
Tubos de plastico (15 ml y 50 ml). Ta ambiente

NOTA:Tras la recepcién, almacene los componentes perecederos (A-I) en la nevera.

NOTA:Ninguno de los componentes de este kit se ha preparado a partir de material
humano.

NOTA:Todos los componentes de este kit estan destinados a la investigacion educativa.
No pueden ser utilizados con fines de diagndstico o médicos, ni pueden ser
administrados o consumidos por seres humanos o animales.



2.1 Material requerido y no suministrado

e Agua destilada.

¢ Vasos de vidrio o matraces.

e Guantes desechables de laboratorio.

e Gafas protectoras.

¢ Micropipetas automaticas (5-50 pl) y (100-1000 pl) puntas.

3. INTRODUCCION

Los anticuerpos son proteinas humanas y animales especificas que se producen por
las células blancas de la sangre en respuesta a materiales extrafios. Ejemplos de tales
materiales extrafios, conocidos como antigenos, incluyen agentes infecciosos y diversos
materiales ambientales "no propios". Los antigenos bioldgicos son biomoléculas de
elevado peso molecular, tales como proteinas, carbohidratos y acidos nucleicos que
pueden estar circulando libremente o como parte de un complejo, como parte de una
cubierta de un virus o de la superficie celular bacteriana. Los anticuerpos son
producidos en respuesta a antigenos. Se unen a los antigenos y juegan un papel
significativo en la posterior eliminacién de dichos materiales en circulacién. Por ejemplo,
la exposicion a un agente infeccioso hace que el individuo inicie una respuesta inmune
que finalmente resulta en moléculas de anticuerposen el plasma que se unen a
diferentes proteinas virales (y/o diferentes areas del mismo polipéptido).

Cuando un anticuerpo se une a un antigeno bioldgico especifico, se pueden reconocer
cargas quimicas especificas, secuencias o elementos estructurales. Estas caracteristicas
de unién estructurales constituyen la huella digital especifica para un antigeno. Cada
molécula de anticuerpo puede unirse a dos moléculas de antigeno. Este reconocimiento
y la unién es altamente especifica y hace posible la diferenciaciéon entre los dos virus
circulantes que pueden estar muy estrechamente relacionados, como en el caso de dos
cepas del mismo virus.

Cuando un antigeno y sus anticuerpos forman complejos insolubles, esta reaccién de
union altamente especifica es conocida como la inmunoprecipitacién. La precipitacién
del complejo es el resultado de diversos anticuerpos policlonales que se unen a los
antigenos para formar una red. En el ensayo de inmunoprecipitacion tradicional, los
anticuerpos se obtienen a partir del suero de un animal expuesto al antigeno especifico.
El suero, también conocida como plasma, se prepara por la eliminaciéon de las células
rojas de la sangre. Contiene las proteinas especificas, los anticuerpos, que actuan
contra un antigeno particular "no propio" que se introduce en el animal, ya sea por
disefo o por una infeccidn. Los anticuerpos son purificados a partir de muestras de
suero de los animales y se pueden utilizar para detectar antigenos particulares, tales
como agentes infecciosos humanos.

Descripcion de la prueba de detecciéon inmunolégica
Los enzimo-inmunoensayos (ELISA’s) fueron desarrollados originalmente para la

medicion de anticuerpos. Estos inmunoensayos también se han adaptado con éxito para
detectar muestras que contienen antigenos. El ELISA se realiza en placas de
microtitulacion que generalmente estdn hechas de poliestireno o cloruro de polivinilo.
Las placas son algo transparente y contienen muchos pozos pequefios (pocillos), en los
que se depositan las muestras liquidas.



Los cientificos agregan las muestras de prueba y los controles a los pocillos de la placa
de plastico, donde no se adhieren especificamente a los pocillos a través de
interacciones hidrofdobicas y electrostaticas (Figura 1). Esto significa que cualquier
proteina en la muestra, y no solo el objetivo deseado, puede adherirse al plastico. A
continuacion, el anticuerpo primario se agrega a los pozos y la mezcla se deja incubar
por un corto tiempo. Este anticuerpo reconoce especificamente y se une a la molécula
objetivo (Figura 1). Por lo tanto, si alguna proteina objetivo esta presente en los
pocillos de microtitulacion, el anticuerpo primario lo reconocera.

Después de un breve periodo de incubacion, los pocillos se lavan para eliminar cualquier
anticuerpo primario que no se haya unido al antigeno. Después del lavado, se agrega
un anticuerpo secundario unido a HRP a los pocillos donde se reconoce y se une al
anticuerpo primario (Figura 1). El exceso de anticuerpo secundario se elimina de los
pocillos lavando varias veces con tampoén. Sin embargo, si el anticuerpo secundario se
ha unido al anticuerpo primario, permanecera en el pozo.
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Finalmente, se agrega una soluciéon de sustrato de ABTS y perdéxido de hidrégeno a
cada pozo. La enzima HRP ligada al anticuerpo secundario puede oxidar el ABTS en los
pocillos donde esta presente el complejo antigeno-anticuerpo, tornando la solucion de
sustrato transparente azul-verde.

Es importante destacar que la reaccién enzima-sustrato solo puede ocurrir si cada paso
del ELISA se realiza correctamente. Si la proteina objetivo no estd presente en la
solucion de la muestra, o si la concentracion es demasiado baja, los anticuerpos
primarios y secundarios no tendran nada con qué unirse y seran eliminados del pozo.
Del mismo modo, incluso si el antigeno estd presenteno se detectarad si se utiliza el
anticuerpo primario incorrecto. En cada uno de estos escenarios, no habra enzima HRP
disponible y el sustrato ABTS permanecera incoloro.

Durante un ELISA cuantitativo, algunos de los pocillos contendran soluciones donde ya
se conoce la concentracion del antigeno. Estas muestras se crean comiinmente al
diluir el antigeno para crear una curva estandar que contiene un amplio rango
de concentraciones de antigeno. La intensidad del sustrato en las muestras
desconocidas se puede comparar con la curva estandar para determinar una
concentracion de antigeno aproximada.



En este experimento, se realizara un ELISA para examinar dos antigenos
diferentes en muestras experimentales. El anticuerpo primario 1 solo
detectara el antigeno A, mientras que el anticuerpo primario 2 es especifico
para el antigeno B. Ambos anticuerpos primarios pueden ser detectados por el
mismo anticuerpo secundario. Se crearan curvas estandar para cada par de
antigenos y anticuerpos para permitir una cuantificacion precisa de las
proteinas. Finalmente, se examinara la especificidad del ELISA intercambiando
los pares antigeno-anticuerpo.

4. DESCRIPCION DEL EXPERIMENTO

El objetivo de esta practica es realizar y dominar los conceptos experimentales
y la metodologia implicados en un ensayo por inmunoabsorciéon ligado a
enzimas (ELISA). Los estudiantes realizaran un ELISA para detectar la
concentracion de dos antigenos diferentes. Se creara una curva estandar para
cada antigeno para permitir una cuantificacibn precisa en muestras
desconocidas.

4.1 Precauciones
1. Se deben usarlos guantes y gafas de protecciéon de forma rutinaria como buenas
practicas de laboratorio.

2. Deben tener mucho cuidado al trabajar con equipos que utilizancalor y/o fusion de
los reactivos.

3. NO PIPETEAR LOS REACTIVOS CON LA BOCA- PIPETEARCON PERAS DE SUCCION.

4. Lavarsebien siempre las manos con agua y jabon después de manipular reactivos o
materiales bioldgicos del laboratorio.

5. Tener cuidado al usar cualquier equipo eléctrico en el laboratorio.

4.2 Requisitos de tiempo (aproximado) de los procedimientos de la practica

Este experimento estd destinado a ejecutarse en el transcurso de un Unico periodo de
laboratorio y debe tomar aproximadamente 45-60 minutos. Si es necesario, el
experimento se puede detener después del primer lavado. Indique a los estudiantes que
agreguen tampoén de lavado a cada pocillo de sus platos, cubran con cuidado con una
envoltura de plastico o coloquelos en una bolsa de plastico para evitar la evaporacion, y
guarde las placas durante la noche a 4 °© C. No recomendamos almacenar las placas
durante mas de 24 horas antes de continuar con el experimento.

4.3 Preparaciones previas

Notas a los preparativos del profesor de la practica
El tamafio de la clase, la duracién de las clases de practicas y la disponibilidad de los

equipos son factores que deben ser considerados en la planificacion e implementacion
de esta practica con sus alumnos. Estas directrices pueden adaptarse para encajar en
sus circunstancias especificas.



Preparation for: What to do: When: Time Required:
Divide microtiter plates Before the class period 5 min.
M&dulo LELISA Prepare and Aliquot Reagents Uptolweekbeforethelab 30 min.
Cuantitativo
Prepare secondaryantibody Same day as the lab 10 min.

A. PREPARATIVOS ANTES DELA PRACTICA
Placas de microtitulacion
1. Como se muestra en la figura2, orientar las placas de microtitulacion de modo que

los nimeros 1-12 estén en la parte superior y las letras A-H estén a la izquierda.
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2. Cortar cada placa a lo largo de las lineas continuas como se muestra en la figura 3.
Cada pieza contendra 3 pocillos en un eje y 8 pocillos en el otro eje. Cada grupo de
laboratorio recibira dos piezas.

Preparacion del antigeno

Los antigenosutilizados en esteexperimento se
suministrancomoproteinasliofilizadas y debenrehidratarse antes de
suuso. Sigalasinstrucciones a continuacidnparapreparar los Antigenos A y
B comoreservas de 8 puyg / ml. Se utilizardnparaque los
estudiantescreencurvasestandar, asicomoparalasmuestrasdesconocidas.

1. Dispense 1,6 ml del tampdén de dilucion (componente C) en 10 tubos de
microcentrifuga y etiquételoscomo”tampon de dilucion". Reserve el tampoén
restante para la preparacion de lasmuestras de antigeno.

2. Transfiera 5 ml de tampdn de dilucién (componente C) a untubocénico de 15 ml.
Etiquete el tubo “"A1".

3. Transfieraaproximadamente 0,5 ml del tampdn de dilucidén del paso 2 al tubo del
antigeno A (componente A). Pipetearhaciaarriba y haciaabajo o agitar en
vortexparamezclar.

4. Transfieratodo el contenido del Antigeno A reconstituido al tubo de 15 ml del
paso 2. Mezclebien.



5. Dispense 180 puL de AntigenoAreconstituido en dieztubos de microcentrifuga s de
0,5 ml. Etiquete los tuboscomo "A1l".Guarde el antigenoA restante
paralasmuestrasdesconocidas.

6. Con untubocoéniconuevo de 15 ml, repita los pasos 2-4 para Antigen B
(Componente B).

7. Dispense 180 pyL de Antigeno B reconstituido en dieztubos de microcentrifugade
0,5 ml. Etiquete los tuboscomo "B1".Guarde el antigeno B restante
paralasmuestrasdesconocidas.

Preparacion de lasmuestrasdesconocidas

1. Etiquete un tubo de 5 ml como "Descl" y un segundo tubo como "Desc2" y
prepare las muestras desconocidas utilizando el tampdn de dilucion y los antigenos
rehidratados de la seccién anterior.

Muestra TamponDilucio Antigeno A Antigeno B
n

Desconocidal 2600 pL 1300 pL 50 pL

Desconocida 2 3400 pL 20 pL 580 pL

2. Dispense 360 pL de Descl en diez tubos de microcentrifuga de 0.5 mL. Etiquete los
tubos como "Descl1".
3. Dispense 360 pL de Desc2 en diez tubos de microcentrifuga de 0.5 mL. Etiquete los
tubos como "Desc2".

Preparacion Anticuerpos primarios

1. Transfiera 12 ml de tampdn de dilucién (componente C) a un tubo cénico de 15 ml.
Etiquete el tubo “"AntiA”.

2. Retire con cuidado el tapon del vial del anticuerpo primario A (componente D) y
transfiera aproximadamente0.5 ml del tampdn de diluciéon del paso 1. Cierre el tapén y
agite suavemente el vial de vidrio para mezclar.

3. Transfiera todo el contenido del anticuerpo primario reconstituido al tubo de 15 ml
del paso 1. Mezcle bien.

4. Dispense 1.1 mL de Anticuerpo Primario A en 10 tubos de microcentrifuga. Etiquete
los tubos como "AbA" o "1°A".

5. Repita los pasos 1-3 para el Anticuerpo B (Componente E) usando un tubo cdnico
nuevo de 15 ml.

6. Dispense 1.1 ml de anticuerpo primario B en 10 tubos de microcentrifuga. Etiquete
los tubos como "AbB" o "1°B".

Preparacion Tampon de Lavado 1X
1. Agregue el contenido del tampon de lavado 10x (componente F) a 540 ml de agua

destilada. Mezclar bien.

2. Dispense 55 ml del Tampdn de lavado diluido en un vaso pequeno para cada grupo.
Etiquetar los vasos de precipitados "Tampén de lavado". Guarde el tampdn de lavado
restante para rehidratar el anticuerpo secundario.



B. PREPARATIVOS EL DIA DELA PRACTICA

Dilucion Anticuerpo Secundario
NOTA: debe usar el Tampon de Lavado Diluido para preparar el anticuerpo
secundario.

1. Transfiera 19 ml de tampon de lavado diluido a un tubo coénico de 50 ml. Etiquete el
tubo "2 ° AB".

2. Retire con cuidado el tapon del vial del anticuerpo secundario (componente G) y
transfiera aproximadamente0.5 ml del tampon de lavado del tubo en el paso 1. Cierre
el tapén y agite suavemente el vial de vidrio para mezclar.

3. Transfiera todo el contenido del anticuerpo secundario reconstituido al tubo de 50 ml
del paso 1. Mezcle bien.

4, Etiquete 10 tubos de microcentrifuga™2°AB" y dispense 1.9 ml por tubo.

Preparacion del Substrato ABTS y Solucion STOP

1. Dispense 1.9 mL de ABTS (Componente H) en 10 tubos de microcentrifuga. Etiquete
los tubos como "ABTS".

2. Dispense 1.9 mL de Solucién STOP (Componente I) en 10 tubos de microcentrifuga.
Etiquete los tubos como "Stop".

NOTA: La soluciéon de parada puede precipitar cuando se almacena a 4 ° C. Si se ve un
precipitado, caliente suavemente la solucién para volver a suspenderla antes de la
alicuota.

C. REACTIVOS PARA LA PRACTICA
Cada grupo de practicas debe recibir los siguientes componentes antes de iniciar el
procedimiento experimental:

10 tubos vacios de microcentrifuga de 0,5 ml

2 placas de microtitulacion (pozo 3x8)

1 tubo de microcentrifuga que contiene 1,6 ml de tampdn de dilucién

1 tubo de microcentrifuga que contiene 180 pL de antigeno A (A1)

1 tubo de microcentrifuga que contiene 180 pL de antigeno B (B1)

1 tubo de microcentrifuga que contiene 360 uL de Desconocida 1 (Descl)
1 tubo de microcentrifuga que contiene 360 uL de Desconocida 2 (DESc2)
1 tubo de microcentrifuga que contiene 1.1 ml de anticuerpo A (AbA)

1 tubo de microcentrifuga que contiene 1.1 ml de anticuerpo B (AbB)

1 tubo de microcentrifuga que contiene 1.9 ml de anticuerpo secundario (2°AB)
1 tubo de microcentrifuga que contiene 1.9 mL de sustrato (ABTS)

1 tubo demicrocentrifuga que contiene 1.9 ml de soluciéon de STOP (STOP)
1 pipeta de transferencia

1 vaso que contiene 55 ml de tampdn de lavado PBST 1X

Toallas de papel

4.5Evitar los errores mas comunes
1. Los estudiantes han de tener mucho cuidado al transvasar soluciones dentro y

fuera de los pocillos de la placa de microtitulacion.

2. Usar solo pipetas limpiasycorrectamentemarcadasy evitar la contaminacion de los
pocillos adyacentes.

3. No intentar vaciar los pocillos de microtitulaciénagitando la placa. No funcionara
yprovocara la contaminacién de los pocillos adyacentes.

4. Lavar los pocillos con cuidado y lentamente, sin fuerza.



5. PRACTICA
MODULO 1. Analisis cuantitativo del ensayo de inmunoabsorcion enzimatica

(ELISA)

Diluciones de las proteinas estandar
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1. PREPARAR los tubos de Antigeno A (Al) y Antigeno B (B1) concentrados, tubos
vacios de microcentrifugay un tubo de Tampodn de Dilucidn.

2. ETIQUETE 5 tubos como A2-A6 para el Antigeno A, y un segundo conjunto de tubos
como B2-B6 para el Antigeno B.

3. Usando una micropipeta, AGREGUE 150 pL de tampdn de dilucién a cada uno de los
tubos de microcentrifuga etiquetados del paso 2.

4, TRANSFERIR 50 pL de antigeno del tubo A1l al tubo A2.

5. MEZCLAR completamente la muestra pipeteando arriba y abajo 5 veces.

6. Usando la misma punta de pipeta, TRANSFERIR 50 pL del tubo A2 al tubo A3 y
mezclar como en el paso 5.

7. Continlle DILUYENDOen serie las muestras restantes a través del tubo A6.

8. REPITA los pasos 4-7 para crear diluciones en serie de Antigeno B.
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9. OBTENGA dos placas ELISA de microtitulacién y tubos de Desconocido 1 vy
Desconocido 2. Cada placa contiene 3 columnas y 8 filas de pocillos.

10. Con un marcador de punta fina, ETIQUETAR la columna izquierda de cada placa
como "1", la columna central como "2" y la columna derecha como "3". Finalmente,
DIBUJA una linea entre las filas 6 y 7 en ambas placas. Solo utilizara los pocillos en la
seccién superior de cada placa.

11. Con una punta de pipeta nueva, TRANSFERIR 50 uL del tubo A1l al pozo superior
izquierdo de CADA placa (columna 1, fila 1).

12. Con una punta de pipeta nueva, TRANSFERIR 50 pL del tubo A2 al pozo
directamente debajo de la muestra del paso 11 (columna 1, fila 2).

13. Continie TRANSFERIR 50 pL de las muestras restantes de Antigeno A en los pocillos
correspondientes de la columna 1 en ambas placas.

14. Con una punta de pipeta nueva, TRANSFERIR 50 pL del tubo Bl al pozo central
superior de CADA placa (columna 2, fila 1).

15. Con una punta de pipeta nueva, TRANSFERIR 50 pL del tubo B2 al pozo
directamente debajo de la muestra del paso 14 (columna 2, fila 2).

16. Continle agregando 50 pL de las muestras restantes de Antigeno B en los pocillos
correspondientes de la columna 2 en ambas placas.
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17. Con una punta de pipeta nueva, TRANSFERIR 50 pL del tubo Descl a los tres
pocillos superiores de la columna derecha de CADA placa (columna 3, filas 1-3).

18. Con una punta de pipeta nueva, TRANSFERIR 50 pL del tubo Desc2 a los siguientes
tres pocillos de la columna derecha de CADA placa (columna 3, filas 4-6).

19. INCUBAR ambas placas durante 5 minutos a temperatura ambiente.

ELIMINACION DE MUESTRAS Y LAVADO DE LOS POCILLOS

20. INVERTIR las placas sobre el fregadero o una pila de toallas de papel para retirar
las muestras. Tape suavemente las placas 4-5 veces sobre una toalla de papel nueva.
DESECHE las toallas de papel mojadas.

21. Usando una pipeta de transferencia, AGREGAR el tampén de lavado para llenar cada
pocillo, teniendo cuidado de no llenar en exceso.

NOTA: Para minimizar la contaminacién cruzada, es importante que evite derramar el
tampodn en los pocillos vecinos.



22. REPITA el paso 20 para RETIRAR el tampdn de lavado.
23. Usando la misma pipeta de transferencia, REPITA el lavado por segunda vez.
INVERTIR las tiras sobre toallas de papel frescas y TAP.
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ADICION DE ANTICUERPOS PRIMARIOS Y SECUNDARIOS

24. Usando un marcador de punta fina, ETIQUETAR una placa con "A" y la otra con "B".
25. Usando una nueva punta de micropipeta, AGREGA 50 pL de Anticuerpo Primario A
(AbA) a cada pocillo de muestra en la placa A.

26. Usando una nueva punta de micropipeta, AGREGUE 50 uL de Anticuerpo Primario B
(AbB) a cada pocillo de muestra en la placa B.

27. INCUBAR durante 5 minutos a temperatura ambiente.

28. INVERTIR sobre toallas de papel y TAP. LAVAR los pocillos dos veces como en los
pasos 20-23.

29. Usando una nueva punta de micropipeta, AGREGUE 50 pL del Anticuerpo
Secundario (2°AB) a cada pocillo de muestra en AMBAS placas.

30. INCUBAR durante 5 minutos a temperatura ambiente.

31. INVERTIR sobre toallas de papel y TAP. LAVAR los pozos dos veces como en los
pasos 20-23.
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32. Usando una nueva punta de micropipeta, AGREGUE 50 uL de sustrato ABTS a cada
pocillo de muestra en AMBAS placas.

33. INCUBA la placa durante 2 a 5 minutos a temperatura ambiente, o hasta que el
color ya no cambie en los pocillos con las concentraciones mas altas de antigeno.
NOTA: Es importante que no se permita que la reaccion contintie durante mas
de 10 minutos, ya que la reaccién enzimatica puede saturarse en las
concentraciones mas altas de sustrato.

34. Usando una nueva punta de micropipeta, AGREGUE 50 uL de Soluciéon STOP a cada
pocillo de muestra en AMBAS placas. Suavemente toque las placas para MEZCLAR.

35. DOCUMENTAR los resultados utilizando una camara digital para tomar una foto. La
colocacién de las placas en una hoja de papel blanca o en una caja de luz blanca puede
aumentar el contraste entre los pocillos.

36. PROCEDA inmediatamente al Médulo II: Analisis de ELISA cuantitativo.

MODULO II-A. Analisis del ELISA cuantitativo

1. OBSERVE el color de las reacciones en sus curvas estandar en ambas placas. Debe
haber un sustrato verde fuerte en los pocillos mas concentrados que se desvanecen
gradualmente en los pozos que recibieron muestras mas diluidas (a medida que baja
una columna).

2. CONFIRMAR que los anticuerpos solo pudieron detectar sus antigenos especificos - El
anticuerpo A solo debe detectar el antigeno A - examinando la columna 2 en la placa A
y la columna 1 en la placa B.

3. Comparar visualmente las intensidad de color de las diferentes diluciones con las
desconocidas, ESTIMAR la concentracion de Antigenos A y B en las dos muestras
Desconocidas. Registre sus resultados.

Tabla :Concentraciones y diluciones de lascurvasestandar

Antigeno A Curvaestandar Antigen B Curvaestandar
Dilucion Concentracion Dilucion Concentracion

Linea 1 1.1 8 pg/mL 1:1 8 pg/mL

Linea 2 1:4 1:4

Linea 3 1:16 1:16

Linea 4 1:64 1:64

Linea 5 1:256 1:256

Linea 6 1:1024 1:1024




MODULO II-B. Analisis cuantitativo
Para una determinacion exacta ver el apéndice 1.

La intensidad del color de cada pocillo se puede determinar utilizando densitometria,
que es una medida cuantitativa de la absorcion de luz. En este ELISA, la concentracién
inicial de antigeno determina cuantas moléculas de ABTS se oxidan. El ATBS oxidado
hace que la solucion sea verde, lo que conduce a una mayor absorcién de la luz. Por lo
tanto, al medir la intensidad del color de la muestra en los pocillos de la curva estandar
de concentracion conocida, podemos establecer una relacion entre la concentracion de
antigeno y la absorcidn de luz. Esta relacion se describe por la ecuaciéon de la curva
estandar. Usando la ecuacion podemos estimar la concentracion original de antigeno en
la muestra desconocida.

6. RESULTADOS

Un ELISA representativo se puede ver a continuacion. La intensidad de las reacciones
variarad ligeramente debido a las diferencias en los tiempos de incubacion y la
temperatura de los reactivos, pero los resultados deberian ser similares.

Las muestras desconocidas deben compararse con las curvas estandar para determinar
la concentracién de antigeno en cada muestra.

A | Bl



7. Apéndice 1

1. Calculate the mean gray value and the protein concentration for the standard curve wells of each antigen.
3. SAVE the digital image of your results as a JPEG on the computer.

b. OPEN the ImageJ program on your computer. O
C.  Go to File > Open and open your image. NOTE:
d.  Goto Image > Type > 32 bit. | Detailed download instuctions

. for Image/ can be found at: »
e. Goto Edit > Invert. http://rsh.info.nih.gov/ij/download htmi |
f. Goto Analyze > Set Measurements and select “mean gray value”. i

NOTE: In digital images each pixel has a luminance - or light intensity - value which ranges from black (zero
intensity) to white (full intensity). In Image J this value is called gray value. The mean gray value is calcu-
lated by adding all the gray values in a selection and then dividing by the total number of pixels.

g. CHOOSE the round selection tool and

T T— Table 1: Calculations fqr the Standard Curve of Antigen A

h. Go to Analyze > Measure. A new | i L -
window titled results should appear. Well | Dilution | Me\iﬁg ) | cﬁggﬁ:ﬁon
RECORD the results for “mean gray i 11 L8 ugimL
value” in your lab notebook or in the ~ ;

2 14
table below.

i.  Click back to the digital image of 3 1:16
your results and use the mouse 4 164
or arrow keys to MOVE the circle 5 1:256
to next well. REPEAT step h for all 6 11024

remaining wells on both plates.

j. COMPLETE Tables 1 and 2 (at right)

using the mean gray values and the Table 2: Calculations for the Standard Curve of Antigen B

antigen concentrations from Table 3 L | Mean Gray Antigen B
on page 22. Yol | e . Value | Concentration
OPTIONAL: If a spectrophotometer is avail- ! i S,
able, the absorbance of ABTS can be mea- 2 1:4 :
sured at 420 nm. Transfer the samples to 3 116
the appropriate plate or cuvette and mea- f ,
sure the absorbance of the standard curve 4 1:64
and Unknown samples. The standard curve 5 1:256
can then be used to accurately measure the 6 11024

concentration of antigens in the Unknown

samples.



2. (reate a standard curve. /
a. PLOT the antigen concentra- | 250
tion (x axis) against the mean |
gray value (y axis) foreach |
standard concentration for | 200
Antigen A. :
b. DRAW a best-fit curve through |
the points in the graph (for
best results we suggest using
graphing software). Record
the equation for your curve
for use later.
. REPEAT Steps 2a and 2b for
Antigen B.

150

100

Mean Pixel Intensity
1o}

50

NOTE: The best-fit line may not pass | 5 4 % b & B b G B @
through every data point. Antigen A Concentration (pg/ml)
3. Determine the concentration of
target protein in the unknown
samples.
3. Find the mean gray values of
the sample in the unknown wells as in step 1.
b. Determine the average gray value for each unknown sample.
¢.  From the Y-axis of the standard curve graph, extend a horizontal line from this absorbance value to the
standard curve. At the point of
intersection extend a vertical
line to the X-axis and read the 250
corresponding concentration. |
Alternatively use the equation |
of the best-fit curve to solve
for x given the y value (see
Figure 4). You will have to do
this twice for each unknown -
once for antigen A and again
for antigen B.

Figure 3: Plotting a Standard Curve.

Mean Pixel Intensity

Based on your calculations, what is the
concentration of each antigen in the
unknown samples?

0 1 2 3 4 5 6 7 8 9

Antigen A Concentration (pg/mL)

Figure 4: Determining a Protein Concentration.



